Subject: Use IDL Workbench with other languages?
Posted by jeffnettles4870 on Mon, 14 Jan 2008 18:21:48 GMT

View Forum Message <> Reply to Message

Hi folks,

| don't have IDL 7 yet, so i haven't seen the new Workbench. | have,
however, been reading the myriad of posts about it here on the
newsgroup, and am both exciting and afraid of getting it :) | know

that the Workbench is based on Eclipse, which, I think, is a java
development platform that can be used for developing in many languages
(other than java). So, if I get IDL 7, am | going to be able to use

it for development in other languages (say, PERL)? Or will I have to
separately download, install, and (gulp) configure the "real”

Eclipse? I'd love to have one development environment for all the
languages i routinely use.

Jeff

Subject: Re: Use IDL Workbench with other languages?
Posted by David Fanning on Tue, 15 Jan 2008 03:53:09 GMT

View Forum Message <> Reply to Message

jeffnettles4870@gmail.com writes:

> | don't have IDL 7 yet, so i haven't seen the new Workbench. | have,

> however, been reading the myriad of posts about it here on the

> newsgroup, and am both exciting and afraid of getting it :) | know

> that the Workbench is based on Eclipse, which, I think, is a java

> development platform that can be used for developing in many languages
> (other than java). So, ifl getIDL 7, am | going to be able to use

> it for development in other languages (say, PERL)? Or will | have to

> separately download, install, and (gulp) configure the "real"

> Eclipse? I'd love to have one development environment for all the

> languages i routinely use.

Jeff, did you get an answer to this question? I've been
asked this several times myself, and | don't know. | expect
it is something people will WANT to know.

Cheers,

David

David Fanning, Ph.D.
Fanning Software Consulting, Inc.
Coyote's Guide to IDL Programming: http://www.dfanning.com/
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Sepore ma de ni thui. ("Perhaps thou speakest truth.")

Subject: Re: Use IDL Workbench with other languages?
Posted by jeffnettles4870 on Tue, 15 Jan 2008 04:52:30 GMT

View Forum Message <> Reply to Message

Jeff, did you get an answer to this question? I've been
asked this several times myself, and | don't know. | expect
it is something people will WANT to know.

Cheers,

David

David Fanning, Ph.D.

Fanning Software Consulting, Inc.

Coyote's Guide to IDL Programming:http://www.dfanning.com/
Sepore ma de ni thui. ("Perhaps thou speakest truth.")

VVVVVVVYVVYVYVYV

Nope, nothing yet....If | hear anything I'll post it here.

Jeff

Subject: Re: Use IDL Workbench with other languages?
Posted by David Fanning on Tue, 15 Jan 2008 04:59:55 GMT

View Forum Message <> Reply to Message

jeffnettles4870@gmail.com writes:

> Nope, nothing yet....If | hear anything I'll post it here.
Oh, oh. That makes me nervous. :-(

Cheers,

David

I-Z;avid Fanning, Ph.D.

Fanning Software Consulting, Inc.

Coyote's Guide to IDL Programming: http://www.dfanning.com/
Sepore ma de ni thui. ("Perhaps thou speakest truth.")
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Subject: Re: Use IDL Workbench with other languages?
Posted by Nigel Wade on Tue, 15 Jan 2008 10:57:00 GMT

View Forum Message <> Reply to Message

David Fanning wrote:

> jeffnettles4870@gmail.com writes:

>

>> | don't have IDL 7 yet, so i haven't seen the new Workbench. | have,
>> however, been reading the myriad of posts about it here on the

>> newsgroup, and am both exciting and afraid of getting it ;) | know
>> that the Workbench is based on Eclipse, which, | think, is a java

>> development platform that can be used for developing in many languages
>> (other than java). So, if | get IDL 7, am | going to be able to use

>> it for development in other languages (say, PERL)? Or will | have to
>> separately download, install, and (gulp) configure the "real”

>> Eclipse? I'd love to have one development environment for all the
>> |anguages i routinely use.

>

> Jeff, did you get an answer to this question? I've been

> asked this several times myself, and | don't know. | expect
> itis something people will WANT to know.

>

> Cheers,

>

> David

Also the reverse situation.

| already have Eclipse installed, and it is used extensively for other language
development. Would installing the IDL 7 workbench interfere, or merge with, the
Eclipse which is already installed and configured?

Installing Eclipse is trivial. Getting the necessary plugins to make it work

with non-native languages (Python, PHP, etc.) is mildly taxing. As you have
already discovered, making it talk to an SVN server is quite entertaining...

But as I've already done this it would be a nuisance to have to do it all again

for the IDL workbench, and even more annoying to have to maintain two separate
(possibly conflicting) Eclipse installations.

Nigel Wade, System Administrator, Space Plasma Physics Group,
University of Leicester, Leicester, LE1 7RH, UK

E-mail : nmw@ion.le.ac.uk

Phone: +44 (0)116 2523548, Fax : +44 (0)116 2523555

Subject: Re: Use IDL Workbench with other languages?
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Posted by Paul Van Delst[1] on Tue, 15 Jan 2008 13:54:49 GMT

View Forum Message <> Reply to Message

David Fanning wrote:

> jeffnettles4870@gmail.com writes:

>

>> | don't have IDL 7 yet, so i haven't seen the new Workbench. | have,
>> however, been reading the myriad of posts about it here on the

>> newsgroup, and am both exciting and afraid of getting it ;) | know
>> that the Workbench is based on Eclipse, which, | think, is a java

>> development platform that can be used for developing in many languages
>> (other than java). So, if | get IDL 7, am | going to be able to use

>> it for development in other languages (say, PERL)? Or will | have to
>> separately download, install, and (gulp) configure the "real"

>> Eclipse? I'd love to have one development environment for all the
>> languages i routinely use.

>

> Jeff, did you get an answer to this question? I've been

> asked this several times myself, and | don't know. | expect

> itis something people will WANT to know.

A different question: Let's say you already have Eclipse installed on your system and you
use it with a bunch of different plugins, e.g. Fortran95(Photran), ruby(RDT), some
Python(Pydev) and Javascript(JSECIipse).

So, since the IDL Workbench is based on Eclipse, can you install the IDL Workbench DE as a
plugin to your existing install?

Going in the other direction (i.e. installing Workbench and then other Eclipse plugins)
seems possible:
http://lwww.ittvis.com/idl/IDL7 _FAQ.asp#wp999301

But, some words are:

"Because the IDL Workbench *includes* [emphasis mine] the Eclipse platform, ..."
| think it should be the other way around, that is, you have Eclipse and you include the
IDL plugin. Given that the major feature of IDL 7 is the Workbench itself, it doesn't
seems like ITTVIS planned to go the plugin route.

And continuing:
"... any other Eclipse-based feature that requires the platform *should* [emphasis
mine] be able to work within the IDL Workbench environment.”

The use of the word "should" in the above is a bit disconcerting. | do enough testing of
my own software that | would rather not see "it should work" in literature for an
expensive software product. Does ITTVIS have a Testing/QA divison that /isn't/ its user
base? (just kidding :0)

cheers,
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paulv

Subject: Re: Use IDL Workbench with other languages?
Posted by jeffnettles4870 on Tue, 15 Jan 2008 16:00:42 GMT

View Forum Message <> Reply to Message

> And continuing:

> "...any other Eclipse-based feature that requires the platform *should* [emphasis

> mine] be able to work within the IDL Workbench environment."

>

> The use of the word "should" in the above is a bit disconcerting. | do enough testing of
> my own software that | would rather not see "it should work" in literature for an

> expensive software product. Does ITTVIS have a Testing/QA divison that /isn't/ its user
> base? (just kidding :0)

>

> cheers,

>

> paulv

Yeah, that "should" worries me too :)

In the meantime, | should be getting my hands on IDL 7 soon (not sure
why we don't have it already, as a matter of fact). When | get it,

I'll just try and install a Python or PHP plugin and see what

happens. I'll report back, and encourage any other brave soul who
also tries this to do the same :)

Jeff

Jeff

Subject: Re: Use IDL Workbench with other languages?
Posted by David Fanning on Tue, 15 Jan 2008 16:14:46 GMT

View Forum Message <> Reply to Message

jeffnettles4870@gmail.com writes:
Yeah, that "should" worries me too :)

>
>
> In the meantime, | should be getting my hands on IDL 7 soon (not sure
> why we don't have it already, as a matter of fact). When | get it,
> I'll just try and install a Python or PHP plugin and see what

> happens. I'll report back, and encourage any other brave soul who

> also tries this to do the same :)
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It's strangely quiet. | have the feeling people are
holding their breath. :-)

Cheers,

David

David Fanning, Ph.D.

Fanning Software Consulting, Inc.

Coyote's Guide to IDL Programming: http://www.dfanning.com/
Sepore ma de ni thui. ("Perhaps thou speakest truth.")

Subject: Re: Use IDL Workbench with other languages?
Posted by Paul Van Delst[1] on Tue, 15 Jan 2008 16:29:02 GMT

View Forum Message <> Reply to Message

David Fanning wrote:

> jeffnettles4870@gmail.com writes:

>

>> Yeah, that "should" worries me too :)

>>

>> In the meantime, | should be getting my hands on IDL 7 soon (not sure
>> why we don't have it already, as a matter of fact). When | get it,
>> |'ll just try and install a Python or PHP plugin and see what

>> happens. I'll report back, and encourage any other brave soul who
>> also tries this to do the same :)

>

> |t's strangely quiet. | have the feeling people are

> holding their breath. :-)

I'm holding mine on principle. (That must be why I'm always blue when | think about how
much IDL costs and whether taxpayer's get their $$ worth when upgrade time comes around. :0)

cheers,

paulv

Subject: Re: Use IDL Workbench with other languages?
Posted by chris_torrence@NOSPAM on Tue, 15 Jan 2008 16:55:59 GMT

View Forum Message <> Reply to Message

Hi all,

Yes, you can do this. However, here are some caveats:
1. This is not officially supported by ITTVIS. No whining allowed.
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2. We have only done limited testing. We have an excellent test group,
but there was only so much time for testing IDL7.0.

There are two ways you can do this:

A. If you have just a few, small languages, like Python, Perl, etc,
then you can *probably* (emphasis already added) just drop these
plugins into your IDL70/idlde/plugins directory, and everything
*should* (more emphasis) work fine. Stop reading here!

B. For a much larger feature, like the Eclipse Java Development Tools
(JDT), then you probably want to go the other route and drop IDL into
your existing Eclipse install. To do this:

1. Find the three core IDL plugins in your IDL70/idlde/plugins
directory:

com.rsi.idldt_7.0.0.jar

com.rsi.idldt.core_7.0.1.jar

com.rsi.idldt.ui_7.0.0.jar
2. Copy these JAR files into your Eclipse/plugins directory.
3. If you want the IDL documentation, then you'll need to copy all of
the com.rsi.idl.doc.*.jar plugins as well.
4. If you want the language packs, you'll need to copy the ones with
"*.nl*jar" as well.
5. Create a new shortcut to your "eclipse.exe", with the following
command-line options:

C:\Eclipse3.3\eclipse.exe -vmargs -DDMLDir="C:\Program Files\ITT
\IDL70\idIde" -DIDMLDir="C:\Program Files\ITT\IDL70\idIde" -DBMLDir="C:
\Program Files\ITT\IDL70\idlde" -DIDLDir="C:\Program Files\ITT
\IDL70\bin\bin.x86" -DIDL_DIR="C:\Program Files\ITT\IDL70\"

You will obviously need to change the above paths if you are on Unix,
or have installed IDL in a different directory.

6. Start up Eclipse. The first time you start, you will not see the

IDL perspective, and the IDL process won't be started.

7. Go under Window->Open Perspective->Other, and choose IDL. You will
get a bunch of Java null exception errors, and IDL will attempt to

start but fail.

8. Quit Eclipse and restart. At this point, you should be "good to

go".

Things | have noticed:

* | always get a Java null pointer exception when | start the "IDL
FrankenDE". This seems harmless.

* To get the IDL process to start, you must have the IDL Command Line
visible.
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* You cannot seamlessly debug a Java program and an IDL program - for
example, if you are using the Java export bridge, this will fire up an

IDL process that is not the same as the IDL process within your
Workbench - so you can't step from your Java code into your IDL code.

Good luck! If you try this, be sure to post to the newsgroup with any
tips or feedback.

-Chris
ITTVIS

Subject: Re: Use IDL Workbench with other languages?
Posted by jeffnettles4870 on Tue, 15 Jan 2008 17:30:53 GMT

View Forum Message <> Reply to Message

On Jan 15, 11:55 am, Chris Torrence <gorth...@gmail.com> wrote:
Hi all,

Yes, you can do this. However, here are some caveats:

1. This is not officially supported by ITTVIS. No whining allowed.

2. We have only done limited testing. We have an excellent test group,
but there was only so much time for testing IDL7.0.

There are two ways you can do this:

A. If you have just a few, small languages, like Python, Perl, etc,
then you can *probably* (emphasis already added) just drop these
plugins into your IDL70/idlde/plugins directory, and everything
*should* (more emphasis) work fine. Stop reading here!

B. For a much larger feature, like the Eclipse Java Development Tools
(JDT), then you probably want to go the other route and drop IDL into
your existing Eclipse install. To do this:

1. Find the three core IDL plugins in your IDL70/idlde/plugins
directory:

com.rsi.idldt_7.0.0.jar

com.rsi.idldt.core_7.0.1.jar

com.rsi.idldt.ui_7.0.0.jar
2. Copy these JAR files into your Eclipse/plugins directory.
3. If you want the IDL documentation, then you'll need to copy all of
the com.rsi.idl.doc.* jar plugins as well.
4. If you want the language packs, you'll need to copy the ones with
"*.nl*.jar" as well.
5. Create a new shortcut to your "eclipse.exe”, with the following
command-line options:

VVVVVVVVVVVVVVVVVVVVVVVVVVYVYVYVYVYV
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C:\Eclipse3.3\eclipse.exe -vmargs -DDMLDir="C:\Program Files\ITT
\IDL70\idIde" -DIDMLDir="C:\Program Files\ITT\IDL70\idIde" -DBMLDir="C:
\Program Files\ITT\IDL70\idlde" -DIDLDir="C:\Program Files\ITT
\IDL70\bin\bin.x86" -DIDL_DIR="C:\Program Files\ITT\IDL70\"

You will obviously need to change the above paths if you are on Unix,
or have installed IDL in a different directory.

6. Start up Eclipse. The first time you start, you will not see the

IDL perspective, and the IDL process won't be started.

7. Go under Window->Open Perspective->Other, and choose IDL. You will
get a bunch of Java null exception errors, and IDL will attempt to

start but fail.

8. Quit Eclipse and restart. At this point, you should be "good to

go".

Things | have noticed:

* | always get a Java null pointer exception when | start the "IDL
FrankenDE". This seems harmless.

* To get the IDL process to start, you must have the IDL Command Line
visible.

* You cannot seamlessly debug a Java program and an IDL program - for
example, if you are using the Java export bridge, this will fire up an

IDL process that is not the same as the IDL process within your
Workbench - so you can't step from your Java code into your IDL code.

Good luck! If you try this, be sure to post to the newsgroup with any
tips or feedback.

-Chris
ITTVIS

VVVVVVVVVVVVVVVVVVVVVVVVYVYVYVYVYVYVYV

Sweet! Thanks Chris! I'm glad to hear i have a shot at having one
development environment for the languages i use. I'm even more glad |
get to stop reading at Iltem A in your post above :)

Jeff

Subject: Re: Use IDL Workbench with other languages?
Posted by Nigel Wade on Thu, 17 Jan 2008 09:42:57 GMT

View Forum Message <> Reply to Message

Chris Torrence wrote:

> Hiall,
>

> Yes, you can do this. However, here are some caveats:
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1. This is not officially supported by ITTVIS. No whining allowed.
2. We have only done limited testing. We have an excellent test group,
but there was only so much time for testing IDL7.0.

There are two ways you can do this:

A. If you have just a few, small languages, like Python, Perl, etc,
then you can *probably* (emphasis already added) just drop these
plugins into your IDL70/idlde/plugins directory, and everything
*should* (more emphasis) work fine. Stop reading here!

VVVVYVYVVYVYVYV

I've just tested this on Linux and it does appear to work.

| downloaded the IDL 7 installer and performed a normal installation. | then ran
idlde so that it initialized the basic environment. After that | used the

Eclipse platform manager within the idlde to add additional plugins for C/C++
and Ruby. I've not looked for a Perl plugin as yet.

To add additional features to Eclipse you run the manager in Help->Software
Updates->Find and install... and in the Feature Updates panel you select
"Search for new features to install* and click on Next. This should then
display the standard location for updates and additional features. C/C++ and
Ruby/TCL are available here, plus a whole host of other plugins for things you
are almost certain never to need.

| didn't get any further than this as | don't have an IDL 7 license yet. The
timed demo ran out and shutdown IDL and idlde, including Eclipse.

B. For a much larger feature, like the Eclipse Java Development Tools
(JDT), then you probably want to go the other route and drop IDL into
your existing Eclipse install. To do this:

1. Find the three core IDL plugins in your IDL70/idlde/plugins
directory:

com.rsi.idldt_7.0.0.jar

com.rsi.idldt.core_7.0.1.jar

com.rsi.idldt.ui_7.0.0.jar
2. Copy these JAR files into your Eclipse/plugins directory.
3. If you want the IDL documentation, then you'll need to copy all of
the com.rsi.idl.doc.*.jar plugins as well.
4. If you want the language packs, you'll need to copy the ones with
"*.nl*jar" as well.
5. Create a new shortcut to your "eclipse.exe", with the following
command-line options:

C:\Eclipse3.3\eclipse.exe -vmargs -DDMLDir="C:\Program Files\ITT
\IDL70\idIde" -DIJDMLDir="C:\Program Files\ITT\IDL70\idlde" -DBMLDir="C:

VVVVVVVVVVVVVVVYVYVYVYVYV
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\Program Files\ITT\IDL70\idlde" -DIDLDir="C:\Program Files\ITT
\IDL70\bin\bin.x86" -DIDL_DIR="C:\Program Files\ITT\IDL70\"

You will obviously need to change the above paths if you are on Unix,
or have installed IDL in a different directory.

6. Start up Eclipse. The first time you start, you will not see the

IDL perspective, and the IDL process won't be started.

7. Go under Window->Open Perspective->Other, and choose IDL. You will
get a bunch of Java null exception errors, and IDL will attempt to

start but fail.

VVVVYVVVYVYVYVYV

Unfortunately this didn't work on Linux. When | start Eclipse and open the
perspectives dialog IDL is not there. If | look at the Plugins info | can see
that there is the IDLDT Core (com.rsi.idldt.core). Under system properties |
can see the properties set on the command line:

*** System properties:

BMLDir=/software/rsi/idlI70/idlde/

DMLDir=/software/rsi/idl70/idlde/
IDLDir=/software/rsi/idl70/bin/bin.linux.x86

IDL_DIR=/software/rsi/idl70

JDMLDir=/software/rsi/idl70/idIde/

and the plugin registry shows the 3 plugins as being installed:
com.rsi.idldt (7.0.0) "IDL Workbench" [Installed]
com.rsi.idldt.core (7.0.0) "IDLDT Core" [Resolved]
com.rsi.idldt.ui (7.0.0) "IDLDT UI" [Installed]

but in the Configured features or Configured plug-ins section there is no
mention of any of the com.rsi plugins.

The above is when using my already installed Eclipse 3.2. If | try to use the
latest Eclipse Eurpoa (3.3.1) it's even worse. The plugins don't even show in
the registry.

So it looks like integrating the IDL workbench into an already installed Eclipse
environment on Linux is a non-starter for the moment.

Nigel Wade, System Administrator, Space Plasma Physics Group,
University of Leicester, Leicester, LE1 7RH, UK

E-mail: nmw@ion.le.ac.uk

Phone : +44 (0)116 2523548, Fax : +44 (0)116 2523555

Subject: Re: Use IDL Workbench with other languages?
Posted by chris_torrence@NOSPAM on Thu, 17 Jan 2008 17:09:40 GMT
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View Forum Message <> Reply to Message

Hi Nigel,

After looking over my post, | left out some details for running IDL
within Eclipse on Linux.

First, this will *only* work with Eclipse 3.3 or greater. There were
too many changes between Eclipse 3.2 and 3.3.

You need to set the LD_LIBRARY_PATH environment variable to point to
both the idlde/bin.linux.x86 and the idI70/bin/bin.linux.x86

directories. Also, the JDMLDir, BMLDir, and DMLDir need to point to

the idlde/bin.linux.x86 directory. On Windows there is no platform-
specific subdirectory...

| created a little shell script called "idl_eclipse" to start up
Eclipse with IDL:

#!/bin/sh

IDL_DIR=/software/rsi/idl70

export IDL_DIR
LD_LIBRARY_PATH=/software/rsi/idl70/idlde/bin.linux.x86:/sof tware/rsi/
idl70/bin/bin.linux.x86

export LD_LIBRARY_PATH

eclipse -vmargs -DJDMLDir=/software/rsi/idl70/idlde/bin.linux.x86 \
-DBMLDir=/software/rsi/idlI70/idlde/bin.linux.x86 \
-DDMLDir=/software/rsi/idl70/idlde/bin.linux.x86 \
-DIDLDir=/software/rsi/idl70/bin/bin.linux.x86 \
-DIDL_DIR=/software/rsi/idl70 &

Note the earlier caveats: the first time you try this, and you start
the IDL perspective, it will fail. After that, as long as the IDL
command line is visible, it should work. You may also receive Java
null exceptions on startup - these can be ignored.

Hope this helps!

-Chris
ITTVIS

Subject: Re: Use IDL Workbench with other languages?
Posted by Nigel Wade on Fri, 18 Jan 2008 15:11:50 GMT

View Forum Message <> Reply to Message

Chris Torrence wrote:
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Hi Nigel,

After looking over my post, | left out some details for running IDL
within Eclipse on Linux.

First, this will *only* work with Eclipse 3.3 or greater. There were
too many changes between Eclipse 3.2 and 3.3.

You need to set the LD_LIBRARY_PATH environment variable to point to
both the idlde/bin.linux.x86 and the idlI70/bin/bin.linux.x86

directories. Also, the JDMLDir, BMLDir, and DMLDir need to point to

the idlde/bin.linux.x86 directory. On Windows there is no platform-
specific subdirectory...

| created a little shell script called "idl_eclipse" to start up
Eclipse with IDL:

#!/bin/sh

IDL_DIR=/software/rsi/idl70

export IDL_DIR
LD_LIBRARY_PATH=/software/rsi/idl70/idlde/bin.linux.x86:/sof tware/rsi/
idl70/bin/bin.linux.x86

export LD_LIBRARY_PATH

eclipse -vmargs -DIJDMLDir=/software/rsi/idl70/idlde/bin.linux.x86 \
-DBMLDir=/software/rsi/idlI70/idlde/bin.linux.x86 \
-DDMLDir=/software/rsi/idl70/idlde/bin.linux.x86 \
-DIDLDir=/software/rsi/idl70/bin/bin.linux.x86 \
-DIDL_DIR=/software/rsi/idl70 &

Note the earlier caveats: the first time you try this, and you start
the IDL perspective, it will fail. After that, as long as the IDL
command line is visible, it should work. You may also receive Java
null exceptions on startup - these can be ignored.

Hope this helps!

-Chris
ITTVIS

VVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVYVYVYVYVYVYV

It does indeed! Thanks very much, | can now run IDL in Eclipse/Europa. All |
need do now is configure Europa so it's the same as my previous version of
Eclipse. Or | could configure the IDL workbench so it's the same as my previous
setup for Eclipse...

Oh, and | need to upgrade the IDL license as well.

Nigel Wade, System Administrator, Space Plasma Physics Group,
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University of Leicester, Leicester, LE1 7RH, UK
E-mail : nmw@ion.le.ac.uk
Phone: +44 (0)116 2523548, Fax : +44 (0)116 2523555

Subject: Re: Use IDL Workbench with other languages?
Posted by wgallery on Fri, 18 Jan 2008 15:41:35 GMT

View Forum Message <> Reply to Message

On Jan 17, 12:09 pm, Chris Torrence <gorth...@gmail.com> wrote:
Hi Nigel,

After looking over my post, | left out some details for running IDL
within Eclipse on Linux.

First, this will *only* work with Eclipse 3.3 or greater. There were
too many changes between Eclipse 3.2 and 3.3.

You need to set the LD_LIBRARY_PATH environment variable to point to
both the idlde/bin.linux.x86 and the idl70/bin/bin.linux.x86

directories. Also, the JDMLDir, BMLDir, and DMLDir need to point to

the idlde/bin.linux.x86 directory. On Windows there is no platform-
specific subdirectory...

| created a little shell script called "idl_eclipse" to start up
Eclipse with IDL:

#!/bin/sh

IDL_DIR=/software/rsi/idl70

export IDL_DIR
LD_LIBRARY_PATH=/software/rsi/idl70/idlde/bin.linux.x86:/sof tware/rsi/
idl70/bin/bin.linux.x86

export LD_LIBRARY_PATH

eclipse -vmargs -DIJDMLDir=/software/rsi/idl70/idlde/bin.linux.x86 \
-DBMLDir=/software/rsi/idlI70/idlde/bin.linux.x86 \
-DDMLDir=/software/rsi/idl70/idlde/bin.linux.x86 \
-DIDLDir=/software/rsi/idl70/bin/bin.linux.x86 \
-DIDL_DIR=/software/rsi/idl70 &

Note the earlier caveats: the first time you try this, and you start
the IDL perspective, it will fail. After that, as long as the IDL
command line is visible, it should work. You may also receive Java
null exceptions on startup - these can be ignored.

Hope this helps!

-Chris
ITTVIS

VVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVYVYVYVYVYVYV
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A question about licensing. | run IDL using a shared network
license. If I include the IDL plugin in a separate Eclipse
installation, then run Eclipse and work on a Fortran project, will an
IDL license be checked out?

Subject: Re: Use IDL Workbench with other languages?
Posted by Nigel Wade on Fri, 18 Jan 2008 17:09:28 GMT

View Forum Message <> Reply to Message

Bill Gallery wrote:

>
> A question about licensing. | run IDL using a shared network

> license. If I include the IDL plugin in a separate Eclipse

> installation, then run Eclipse and work on a Fortran project, will an
> IDL license be checked out?

It looks as though if the IDL perspective is opened it starts IDL, which
presumably requires a license. | don't currently have an IDL 7 license so all |
get is a message about that feature not being supported, so it is attempting to
get one.

Closing the IDL perspective doesn't appear to stop IDL, there is still the IDL
process idl_opserver running in the background. The only way I've found to stop
this is to shutdown Eclipse and restart it, then the IDL process isn't started

(until you open an IDL perspective). I'm still learning...

Nigel Wade, System Administrator, Space Plasma Physics Group,
University of Leicester, Leicester, LE1 7RH, UK

E-mail : nmw@ion.le.ac.uk

Phone: +44 (0)116 2523548, Fax : +44 (0)116 2523555

Subject: Re: Use IDL Workbench with other languages?
Posted by dlindhol on Thu, 14 Feb 2008 21:13:04 GMT

View Forum Message <> Reply to Message

Does this work for 64-bit Eclipse?
I'm trying to run with the IDL 7 idlde plugins in my 64-bit Eclipse
3.3 install on x86_64 Linux.

| routinely get the following in the log when | start up:
IMESSAGE An internal error occurred during: "IDL Core Bundle
Initialization".
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ISTACK 0
java.lang.NullPointerException
at
com.rsi.idldt.core.IDLProcessManager.savelDLDirLocation(IDLP rocessManager.java:
389)
at
com.rsi.idldt.core.IDLProcessManager.initializeDML(IDLProces sManager.java:
136)
at
com.rsi.idldt.core.IDLProcessManager.createlDLProcess(IDLPro cessManager.java:
105)
at com.rsi.idldt.core.IDLDTCorePlugin
$PostCoreBundleStartJob.run(IDLDTCorePlugin.java:242)
at org.eclipse.core.internal.jobs.Worker.run(Worker.java:55)
Everything is there including the command line and the IDL editor but
IDL never starts up.

| got it to work with 32-bit eclipse. It looks like idlde is running
32-bit and the lack of idI70/idlde/bin.linux.x86_64 doesn't give me
much hope.

Thanks,
Doug

Subject: Re: Use IDL Workbench with other languages?
Posted by chris_torrence@NOSPAM on Wed, 20 Feb 2008 23:11:46 GMT

View Forum Message <> Reply to Message

Hi Doug,

Unfortunately, Eclipse 3.3 was not available on all of our 64-bit

platforms when we shipped IDL 7.0. So, our IDL Workbench always runs
as a 32-bit application, and then hooks up to either a 64-bit core IDL
process (on a 64-bit system) or 32-bit core IDL (if you use the -32

flag or you are on a 32-bit system).

So, you will need to run 32-bit Eclipse if you want to experiment with
the IDL "FrankenDE".

Cheers,
Chris
ITTVIS
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